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ABSTRACT 

This research paper an extensive study to control speed of dc motor by different Controller 

like PID or FUZZY Sliding mode in MATLAB simulation as well as experimental Study on 

dcmotor. The system identification technique is used to get the accurate transfer function of 

dc motor system identification is the technique where we give some input to the motor and 
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get output corresponding input and output we get the process model with measured and 

simulation mode through is model get the best fit percentage result after find the transfer 

function of plant we have design the different controller to control the speed/position of the 

motor. We have design PID controller or FUZZY controller for high accuracy speed control. 

 

Keywords – Fuzzy Controller, DC Motor, PID Controller 

 

INTRODUCTION 

A dc motor is a machine or device which converts d.c power into mechanical power. Its 

operation is based on the principle that when a current carrying conductor is placed in a 

magnetic field, the conductor experiences a mechanical force. The direction of force is given 

by Fleming’s left hand rule and magnitude is given by F=Bil newtons, where “B” is magnetic 

flux density, “i” is the current flowing through the conductor and “l” is the length of the 

conductor. The output of the motor is a mechanical output that is the output is a rotational 

motion of the rotor due to this force. A shaft is connected to the rotor and the shaft rotates. 

The speed of rotation depends on various factors. Eg….The speed control can be done by 

controlling those factors. 

 

In the Flux control method speeds higher than the normal speed can be obtained and there is a 

limit to the maximum speed obtainable by this method. It is because if the flux is too much 

weakened, commutation becomes poorer. In the armature control method a large amount of 

power is wasted due to which the output and the efficiency decrease. Hence speed regulation 

is poorer. Voltage control method avoids the disadvantages of poor speed regulation and low 

efficiency as in armature controlmethod. This method is employed for large size of motors 

where efficiency has a great importance. So here we use the voltage control method for the 

speed control. 

 

Proportional-Integral-Derivative (PID) controller has been used for several decades in 

industries for process control applications. The combination of proportional, integral and 
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derivative control action is called PID control action. PID controllers are commonly used to 

regulate the time-domain behaviour of many different types of dynamic plants. These 

controllers are extremely popular because they can usually provide good closed-loop 

response characteristics.The major merit of Fuzzy controller over PI controller is use of 

linguistic variable and user defined rule base that makes it possible to incorporate human 

intelligence in the controller. Fuzzy logic based controller also has the capability to control 

both linear and nonlinear system. Inputs given to the fuzzy logic based controller are speed 

error (e) and change in speed error (∆e). And output is the change of control (ωsl) , which is 

the frequency correction. So the inputs error and change in error are processed according to 

the rule base, which is user defined and output correction is provided to the inverter. The 

membership functions and the rules are defined in FIS editor window. Based on rules, control 

surface is also generated. The system or model for speed controlling of induction drive is 

simulated both with PID and Fuzzy controller and results are analyzed and compared and 

Fuzzy controller is found to perform better than the conventional PID controller. 

 

DC motors is used in many industrial applications such as electric vehicles, steel rolling 

mills, electric cranes, and robotic manipulators due to precise, wide, simple, and continuous 

control characteristics. 

SPEED CONTROL OF DC MOTORS. 

The expression of speed of a DC motor is given as: 

N=[(V-IaRa)/Ø]×k 

 

Therefore speed of DC motor can be varied by controlling the following quantities  

• External resistance in armature circuit R  

• Flux per pole φ 

• Voltage of the armature V 

 

Armature resistance control: 
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In this method armature circuit is provided with a variable resistance. Field is directly 

connected across the supply so that flux is not changed due to variation of series resistance. 

This is applied for dc shunt motor. This method is used in printing press, cranes, hoists where 

speeds lower than rated is used for a short period only.  

 

 

Fig. 1 : Armature resistance control 

N µ V – Ia (Ra + Rc ) 

where  Rc = controller resistance 

 

Due to voltage drop in the controller resistance, the back e.m.f. (Eb) is decreased. Since N µ 

Eb, the speed of the motor is reduced. The highest speed obtainable is that corresponding to 

RC = 0 i.e., normal speed. Hence, this method can only provide speeds below the normal 

speed. 

 

Merits: 

• The ability to achieve speeds below the basic speed. 

• Simplicity and ease of connection. 

• The possibility of combining the functions of motor starting with speed 

control. 

Demerits 
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• The relatively high cost of large, convinouslyrated, variable resistors capable of 

dissipating large amounts of power. 

• Poor speed regulation for any given no load speed setting. 

• Low efficiency resulting in high operating cost. 

• Difficulty in obtaining stepless control of speed in higher power ratings. 

 

Field Flux Control 

It is based on the fact that by varying the flux ϕ, the motor speed (N∞ 1/ϕ) can be changed 

and hence the name flux control method. In this method speed variation is accomplished by 

means of a variable resistance inserted in series with the shunt field. An increase in 

controlling resistances reduces the field current with a reduction in flux and an increase in 

speed. This method of speed control is independent of load on the motor. Power wasted in 

controlling resistance is very less as field current is a small value. This method of speed 

control is also used in DC compound motor. 

 

 

Fig 2 - Field Flux Control 

 

Merits: 

• Good working efficiency. 

• Compact controlling equipment 
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• The speed is not effected by load and speed control can be performed effectively even 

at light loads. 

• Relatively inexpensive and simple to accomplish both manually and automatically. 

 

Demerits: 

• Inability to obtain prefer below the basic speed. 

• Instability at high speeds because of armature reaction. 

• Commutation difficulties and possible commutator damage at high speeds. 

 

Voltage control method 

In this method, the voltage source supplying the field current is different fromthat which 

supplies the armature. This method avoids the disadvantages of poor speed regulation and 

low efficiency as in armature control method. However, itis quite expensive. Therefore, this 

method of speed control is employed for large size motors where efficiency is of great 

importance. 

 

When the speed is controlled by regulating the motor terminal voltage while maintaining 

constant field current, it is called voltage control. With voltage control, the change in speed is 

almost proportional to the change in voltage. The output varies directly with speed and the 

torque remains constant. Since the voltage has to be regulated without affecting the field, the 

application of voltage control is limited to separately excited motors. 

 

Multiple Voltage Control 

In this method, the shunt field of the motor is connected permanently across a fixed voltage 

source. The armature can be connected across several different voltages through suitable 

switchgear. In this way, voltage applied across the armature can be changed. The speed will 

be approximately proportional to the voltage applied across the armature. Intermediate speeds 

can be obtained by means of a shunt field regulator. 
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Ward-Leonard system 

In this method, the adjustable voltage for the armature is obtained from an adjustable-voltage 

generator while the field circuit is supplied from a separate source. The armature of the shunt 

motor M (whose speed is to be controlled) is connected directly to a d.c. generator G driven 

by a constant-speed a.c.motor A. The field of the shunt motor is supplied from a constant-

voltage exciter E. The field of the generator G is also supplied from the exciter E.The voltage 

of the generator G can be varied by means of its field regulator. By reversing the field current 

of generator G by controller FC,the voltage applied to the motor may be reversed. 

Sometimes, a field regulator is included in the field circuit of shunt motor M for additional 

speed adjustment. With this method, the motor may be operated at any speed above its 

maximum speed. 

 

Fig. 3 - Ward-Leonard system 

 

DC MOTOR MODEL: 

A common actuator in control systems is the DC motor. It directly provides rotary 

motion and, coupled with wheels or drums and cables, can provide translational motion. The 

electric circuit of the armature and the free-body diagram of the rotor are shown in the 

following fig 3.1:  
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Fig 4 : Model of a DC Motor 

Here we assume that the input of the system is the voltage source (V) applied to the motor's 

armature, while the output is the rotational speed of the shaft d(theta)/dt. The rotor and shaft 

are assumed to be rigid. We further assume a viscous friction model, that is, the friction 

torque is proportional to shaft angular velocity.  

 

In general, the torque generated by a DC motor is proportional to the armature current and the 

strength of the magnetic field. In this example we will assume that the magnetic field is 

constant and, therefore, that the motor torque is proportional to only the armature current i by 

a constant factor Kt as shown in the equation below. This is referred to as an armature-

controlled motor.  

                                                                                                                         (1) 

The back emf, e, is proportional to the angular velocity of the shaft by a constant factor Ke.  

                                                                                                                         (2) 

In SI units, the motor torque and back emf constants are equal, that is, Kt = Ke; therefore, we 

will use K to represent both the motor torque constant and the back emf constant.  

 

BUILDING THE MODEL IN SIMULINK: 
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This system will be modelled by summing the torques acting on the rotor inertia and 

integrating the acceleration to give velocity. Also, Kirchhoff’s laws will be applied to the 

armature circuit. First, we will model the integrals of the rotational acceleration and of the 

rate of change of the armature current.  

 

                                                                                                              (3) 

 

                                                                                                                    (4) 

To build the simulation model, we open Simulink and open a new model window. Then we 

insert the integrator block from the Simulink continuous library. The model appears as 

 

 

 

Next, we will apply Newton's law and Kirchhoff’s law to the motor system to generate the 

following equations: 

                                                                       (5) 

                                                        (6) 
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Continuing to model these equations in Simulink, we add two Gain blocks and two Add 

blocks from the Simulink library to obtain the model as shown  

 

 

Now, we add in the torques which is represented in the rotational equation. First, we add in 

the damping torque by inserting a gain block below the inertia block.  

 

Next, we add in the torque from the armature by inserting a gain block attached to the 

positive input of the rotational Add block with a line. 

 

The model appears as - 
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Now, we add in the voltage terms which are represented in the electrical equation. First, we  

add in the voltage drop across the armature resistance by inserting a gain block above the 

inductance block. Next, we add in the back emf from the motor by inserting a gain block 

attached to the other negative input of the current add block. 

 

Finally we add In1 and Out 1 blocks from the simulink and subsystems library and 

respectively label them “Voltage” and “Speed” 

 

The final design should look like the figure below. 
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Fig 5 - SIMULINK model of the DC motor 

 

In order to save all of these components as a single subsystem block, we first select all of the 

blocks, then select Create Subsystem from the Edit menu. We name the subsystem "DC 

Motor" and then save the model. 

  

Fig. 6 
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We then extract the model into MATLAB to run for the desired values. We need to identify 

the inputs and outputs of the model we wish to extract. First we right-click on the signal 

representing the Voltage input in the Simulink model. 

Then choose Linearization > Input Point from the resulting menu. Similarly, right-click on 

the signal representing the Speed output and select Linearization > Output Point from the 

resulting menu. The input and output signals should now be identified on your model by 

arrow symbols as shown in the figure below. 

 

Fig 5  : SIMULINK model with input and output 

 

ANALYSYSIS OF THE DC MOTOR MODEL: 

In order to perform the extraction, we select from the model window Tools > Control Design 

> Linear Analysis. We then linearize the model to obtain the step response of the model. 

 

The design requirements of the systems may vary from one system to another. For our case, 

we want a fast response of the system to an error. The overshoot of the system should not be 

higher than 5% and the settling time should be smaller than 2 seconds.  

 

The main design requirements are as follows;  

Settling time should be less than 2 seconds;  
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Overshoot of the system should be less than 5%;  

Steady state error should be less than 1% 

 

By varying the values of the parameters in the m-file we obtain the desired step response 

curve as shown 

 

 

 

From the graph the values obtained are 

Rise time = 1.14 

Settling time = 2.07 

Steady state value = 0.099 

 

From the above values obtained we see that the response is obtained not within the desired 

design parameters. As such we have to use the controllers for better responses. 

 

PID CONTROLLER 
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The combination of proportional, integral and derivative control action is called PID control 

action. PID controllers are commonly used to regulate the time-domain behaviour of many 

different types of dynamic plants. 

 

These controllers are extremely popular because they can usually provide good closed-loop 

response characteristics. 

 

We consider the feedback system architecture where it can be assumed that the plant is a DC 

motor whose speed must be accurately regulate. 

 

 

Fig 6 - DC motor with PID controller 

 

The output of a PID controller, equal to the control input to the plant, in the time-domain is as 

follows: 

 

 

The variable ( ) represents the tracking error, the difference between the desired input value  

( ) and the actual output ( ). This error signal ( ) will be sent to the PID controller, and the 

controller computes both the derivative and the integral of this error signal. The control signal 

( ) to the plant is equal to the proportional gain ( ) times the magnitude of the error plus 

the integral gain ( ) times the integral of the error plus the derivative gain ( ) times the 

derivative of the error.  
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This control signal ( ) is sent to the plant, and the new output ( ) is obtained. The new 

output ( ) is then fed back and compared to the reference to find the new error signal ( ). The 

controller takes this new error signal and computes its derivative and its integral again, ad 

infinitum. 

 

PID controller can be investigated under three main categories. Each controller has different 

properties in terms of controlling the whole system.  

 

In proportional control, adjustments are based on the current difference between the actual 

and desired speed.  

 

In integral control, adjustments are based on recent errors.  

 

In derivative control, adjustments are based on the rate of change of errors. 

 

The Characteristics of P, I, and D Controllers 

A proportional controller ( ) will have the effect of reducing the rise time and will reduce 

but never eliminate the steady-state error. An integral control ( ) will have the effect of 

eliminating the steady-state error for a constant or step input, but it may make the transient 

response slower. A derivative control ( ) will have the effect of increasing the stability of 

the system, reducing the overshoot, and improving the transient response.  

 

The effects of each of controller parameters, , , and on a closed-loop system are 

summarized in the table below 

 

Closed Loop 

Response 

Rise Time Overshoot Settling Time Steady State 

error 

Kp Decrease Increase Small Change Decrease 
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Ki Decrease Increase Increase Eliminate 

Kd Small Change Decrease Decrease No Change 

 

MODELTHE PID WITH DC MOTOR: 

The actual output value is fed back to the system which is then compared to the desired input. 

The error is then fed to the PID controller unit as input to it and hence we get the new output.  

 

 

 

Here we remove the input to the system and implement a controller to the system. A PID 

controller is employed from the continuous library of Simulink.  

 

We then add the sum block from the library. We extend to it the feedback from the DC 

subsystem.  

 

We then introduce the step input to the sum.We finally add a scope to the output to view the 

desired responses. 

 

Finally the SIMULINK model of a PID controller for DC motor speed control is as shown 
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Fig 10: SIMULINK model of a DC MOTOR having PID controller 

 

The inner view of of the controller is 

 

FIG11:- simulink model of a PID controller 

 

Analysis of PID Controller 

For a 1-rad/sec step reference, the design criteria are the following. 

Settling time less than 2 seconds 

Overshoot less than 5% 

Steady-state error less than 1% 
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We then create the input and output points by right clicking and choosing 

Linearization>Input/output points on the reference signal and the signal to the scope 

 

We perform the extraction by choosing Tools>Control Design>Linear Analysis. We then 

linearize the model to obtain the desired step response 

 

Analysis for different values of the parameters of PID controller: 

We now change the values of the PID parameters Kp,Kd and Ki to obtain the various 

responses. 

 

forKi=1,  Kd=1, Kp=100: 

With these values the response obtained is shown below 

 

Fig 7 - step response for Ki=1,Kd=1 and Kp=100 

 

It is seen that we have a very high settling time, which don’t satisfy the design criteria. 

We have rise time = 0.119 

To improve this we increase the value of Ki. 
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for Ki=100, Kd=1, Kp=100 

With these values the response obtained is shown below 

 

Fig 8 : step response for Ki=100, Kd=1 and Kp=100 

 

As we increase the value of Ki, the steady state error becomes zero, which satisfies the 

purpose of adding the integral controller. 

 

We have rise time = 0.11sec and settling time =0.987sec 

 

Ki=200, Kd=1, Kp=100 
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Fig. 9 - step response for Ki=200, Kd=1, Kp=100 

 

Rise time:.102 sec 

Settling time:0.581 sec 

But the overshoot obtained doesn’t satisfy the design criteria. 

As such we increase the value of Kd. 

 

Ki=200, Kd=10, Kp= 100 
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With these values the response obtained is as show

 

               Fig 10 - step response for Ki=200, Kd=10 and Kp=100 

 

Now as we increase the value of Kd, the overshoot becomes zero. 

Also the steady state error becomes zero. 

We have the settling time = 0.266sec and rise time = 0.109sec 

These values satisfy the design criteria. 

 

Analysis of the model with the help of a constant speed: 

We remove the step response block, instead of that we add a constant speed 1500 block to 

analysis the model and compare response. The model is shown as 
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FIG 11 - simulink model of a dc motor having constant speed block 

 

the response for this model will look like as same as previous response. the response is shown 

below. 
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Fig12 - step response for Ki=200, Kd=10 and Kp=100 

 

Response in various forms look like as shown: 

 

Fig13 - Impulse response for Ki=200, Kd=10 and Kp=100 
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Fig. 14 - Pole zero map for Ki=200, Kd=10 and Kp=100 

 

 

 

 

           

 

DESIGN OF MEMBERSHIP FUNCTION (MF) 

Input Variables 

(a) Fuzzy Sets of Speed Error (E) Variable 

Table 3 Membership function of speed error 

Fuzzy set 

(Label) 

 

 
Description  Numerical Range  

Shape of 

Membership 

Function Negative 

large 

(NL) 

 

 

Large Speed 

difference in 

negative direction 

 

 

 

-20 to -20 

-20 to 40 

 

 
Triangular 

       



ISSN (Online) : 2348 - 2001 

 

International Refereed Journal of Reviews and Research 

Volume 3 Issue 5 September - October 2015 

International Manuscript ID : 23482001V3I5092015-01 

(Approved and Registered with Govt. of India) 

 

 

Approved by Council of Scientific and Industrial Research, Ministry of Science and Technology, Govt. of India 

 

 

Negative 

small 

(NS) 

 

 

Small Speed 

difference in 

negative direction 

 

 

 

10 to 40 

40 to 100 

 

 
Triangular 

       Zero 

(ZE) 

 

 

Speed difference is 

zero 

 

 

40 to 70 

70 to 100 

 

 

Triangular 

Positive 

Small 

(PS) 

 

 

Small Speed 

difference in 

positive direction 

 

 

 

40 to 100 

100 to 130 

 

 
Triangular 

Positive 

large 

(PL) 

 

 

Large Speed 

difference in 

positive direction 

 

 

 

100 to 160 

160 to 160 

 

 
Triangular 

 

(b) Fuzzy Sets Of Change In Speed Error (De) Variable 

Table 4 Membership function of change in speed error 

Fuzzy set 

(Label) 

 

 
Description  

Numerical 

Range 
 

Membership 

Function 

Negative 

large 

(NL) 

 

 

Large error difference in 

negative direction 

 

 

 

-1300 to -1300 

-1300 to -800 

 

 
Triangular 

       Negative 

small 

(NS) 

 

 

Small error difference in 

negative direction 

 

 

 

-1050 to -800 

-800 to -300 

 

 
Triangular 

Zero 

(ZE) 

 

 

Error difference is zero  

 

-800 to -550 

-550 to -300 

 

 

Triangular 

Positive 

Small 

(PS) 

 

 

Small error difference in 

positive direction 

 

 

 

-800 to -300 

-300 to -50 

 

 
Triangular 

       Positive 

large 

(PL) 

 

 

Large error difference in 

positive direction 

-300 to -300 

-300 to 200 

 

 
Triangular 

 

Output Variables 

(a) Fuzzy sets for KP 

Table 5 Membership function of proportional gain KP 
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Fuzzy set 

(Label) 

 

 
Numerical Range  Membership function 

Positive very small 

(PVS) 

 

 

0 to 0 

0 to 10 

 

 
Triangular 

Positive Small 

(PS) 

 

 

0 to 5 

5 to 15 

 

 
Triangular 

Positive Medium small 

(PMS) 

 

 

5 to 10 

10 to 20 

 

 
Triangular 

Positive Medium 

(PM) 

 

 

10 to 15 

15 to 20 

 

 
Triangular 

Positive Medium Large 

(PML) 

 

 

10 to 20 

20 to 25 

 

 
Triangular 

Positive Large 

(PL) 

 

 

15 to 25 

25 to 30 

 

 
Triangular 

Positive very Large 

(PVL) 

 

 

20 to 30 

30 to 30 

 

 
Triangular 

(b) Fuzzy sets for Ki 

Table 6 Membership function of integral gainKi 

Fuzzy set 

(Label) 

 

 
Numerical Range  Membership function 

Positive very small 

(PVS) 

 

 

0 to 0 

0 to 20 

 

 
Triangular 

Positive Small 

(PS) 

 

 

0 to 10 

10 to 30 

 

 
Triangular 

Positive Medium small 

(PMS) 

 

 

10 to 20 

20 to 40 

 

 

Triangular 

Positive Medium 

(PM) 

 

 

20 to 30 

30 to 40 

 

 

Triangular 

Positive Medium 

Large 

 

 

20 to 40 

40 to 50 

 

 

Triangular 
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Positive Large 

(PL) 

 

 

30 to 50 

50 to 60 

 

 
Triangular 

Positive very Large 

(PVL) 

 
40to 60 

60 to 60 

 

 

Triangular 

 

(c) Fuzzy Sets for KD 

 

Table 7 Membership function for derivative gain Kd 

Fuzzy set 

(Label) 
Numerical Range 

Shape of Membership 

function 

Positive very small 

(PVS) 

0 to 0 

0 to 2 
Triangular 

Positive Small 

(PS) 

0 to 1 

1 to 3 

Triangular 

Positive Medium small 

(PMS) 

1 to 2 

2 to 4 

Triangular 

Positive Medium 

(PM) 

2 to 3 

3 to 4 

Triangular 

Positive Medium Large 

(PML) 

2 to 4 

4 to 5 
Triangular 

Positive Large 

(PL) 

3 to 5 

5 to 6 
Triangular 

Positive very Large 

(PVL) 

4 to 6 

6 to 6 

Triangular 

 

DESIGN OF FUZZY RULES   

(a) Rule Basesfor Tuning Kp 

 

de/e NL NS ZE PS PL 

NL PVL PVL PVL PVL PVL 
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NS PML PML PML PL PVL 

ZE PVS PVS PS PMS PMS 

PS PML PML PML PL PVL 

PL PVL PVL PVL PVL 
PVL 

 

 

 

 

(b) Rule bases for tuning Ki 

 

de/e  NL  NS ZE  PS  PL 

 

NL 

 

 

 

PM 

 

 

 

PM 

 

PM 

 

 

 

PM 

 

 

 

PM 

NS  PMS  PMS PMS  PMS  PMS 

ZE  PS  PS PVS  PS  PS 

PS  PMS  PMS PMS  PMS  PMS 

PL  PM  PM PM  PM  PM 

 

(c) Rule Bases fortuning Kd 

 

de/e  NL NS ZE PS PL 

 

NL 

 

 

 

PVS 

 

PMS 

 

PM 

 

PL 

 

PVL 
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NS  PMS PML PL PVL PVL 

ZE  PM PL PL PVL PVL 

PS  PML PVL PVL PVL PVL 

PL  PVL PVL PVL PVL PVL 

 

FUTURE SCOPE 

MATLAB simulation for speed control of separately excited DC motor has been done which 

can be implemented in hardware to observe actual feasibility of the approach applied in this 

thesis. This technique can be extended to other types of motors. The parameters of PID 

controller can also be tuned by using genetic algorithm (GA). In large, complex system the 

behaviour of the system is difficult to determine and it may suffer system non linearities such 

like saturation, dead zone etc which degraded the performance of conventional PID 

controller. Such non linearities can be reduced by using fuzzy based PID controller. 

Moreover conventional PID controller required manual tuning while fuzzy based PID 

controller operates automatically. 
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